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Additional Documentation
Additional Documentation Intro

The product documentation set for Siebel eBusiness Applications, Mid Market 
Edition is provided on the Siebel Bookshelf, MidMarket Edition. For general 
information about Siebel product documentation, see the Siebel Bookshelf, 
MidMarket Edition home page and Documentation Roadmap, MidMarket Edition.

Siebel Systems, Inc., reserves the right to modify the documentation for Siebel 
eBusiness Applications at any time. For updates to Siebel documentation, go to the 
SupportWeb site (http://ebusiness.siebel.com/supportweb/). 

If you want to order additional Siebel documentation and copies of the Bookshelf 
CD-ROM, go to Books Online at http://ebusiness.siebel.com/booksonline.

To access both SupportWeb and Books Online, you will need to provide the user 
name and password you received from Siebel Support Services 
(support@siebel.com).

NOTE: All Siebel MidMarket product names include the phrase MidMarket Edition 
to distinguish this product from other Siebel eBusiness Applications.  However, in 
the interest of brevity, after the first mention of a MidMarket product in this 
document, the product name will be given in abbreviated form. For example, after 
Siebel Call Center, MidMarket Edition, has been mentioned once, it will be referred 
to simply as Siebel Call Center. Such reference to a product using an abbreviated 
form should be understood as a specific reference to the associated Siebel 
MidMarket Edition product, and not any other Siebel Systems offering.  When 
contacting Siebel Systems for technical support, sales, or other issues, note the full 
name of the product to ensure its proper identification and handling.
Int ro -2 Siebel Projects User Guide MidMarket Edition Version 7.0
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What’s New in This Release
What’s New in This Release Intro

For a list of features new in this release, see the “What’s New” books included on 
the Siebel Bookshelf, MidMarket Edition CD-ROM. Your Siebel implementation may 
not have all the features described in those guides, depending on which software 
modules you have purchased.

It is also strongly recommended that you read Fundamentals, MidMarket Edition so 
that you can make optimal use of your Siebel application, especially if you are new 
to Siebel software.
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Siebel Systems Welcomes Your Comments
Siebel Systems Welcomes Your Comments Intro

To help us improve our products, we want to know about any corrections or 
clarifications to this guide that you would find useful. Please include in your 
message:

■ The title and version of the guide (very important)

■ The name and version number of the Siebel eBusiness Application you are using

■ Your name, job title or functional area, company name, phone number, and 
email address

Contact us through regular mail or email at:

Siebel Systems, Inc.
Technical Publications Department
2207 Bridgepointe Parkway
San Mateo, CA 94404-5009

doc@siebel.com 

We appreciate your feedback.
Int ro -4 Siebel Projects User Guide MidMarket Edition Version 7.0
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Siebel Projects Overview
Siebel Projects Overview 1

Siebel Projects was designed in consultation with leading professional services 
firms specifically to meet the needs of consulting and service organizations. 

Siebel Projects allows companies to maximize their market potential by closing 
more business and providing a comprehensive solution for managing projects. 
Siebel Projects helps service delivery teams win more deals, deliver services on time 
with high quality, and accurately track resource needs, delivery dates, and revenue 
recognition.

Siebel Projects provides comprehensive support for the entire professional services 
process. Organizations use Siebel Projects to manage leads for customer 
engagements, define project scope, and work breakdown structures, manage 
resources, select and track subcontractors, manage time, expenses and, expose and 
resolve risks related to the project, and guarantee customer satisfaction.
1-2 Siebel Projects User Guide MidMarket Edition Version 7.0
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Professional Services Automation Business Process
Professional Services Automation Business Process 1

This workflow represents a typical Professional Services Business Process.

Figure 1-1. Business Process
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Benefits
Benefits 1

Siebel Projects helps professionals by providing:

■ Risk Tracking and Management

■ Time and Expense Reporting

■ Microsoft Project Integration

■ Opportunity Management

■ Project Management

Roles and Responsibilities 1

The table below shows the sample database employees and their associated 
functional responsibilities. To use these logins, launch the Siebel application or 
Siebel Service application, choose the Sample data source, and enter the login and 
password shown.

Table 1-1. Roles and Responsibility Table

Functional Responsibility Employee Name Login/Password

Principal Consultant Payton Singh PSINGH

Senior Consultant Gary Clark GCLARK

Technical Account Manager Ted Angel TANGEL

Engagement Manager Emily Modi EMODI

Resource Manager Randy McCoy RMCCOY

Consultant Serina Caine SCAINE

System Administrator Sys Admin SADMIN
1-4 Siebel Projects User Guide MidMarket Edition Version 7.0
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Opportunities Management Overview 2

Opportunity Management allows engagement managers to coordinate information 
with sales representatives and access critical sales and customer data. Opportunity 
assessments create tremendous business value by allowing engagement managers 
to identify and focus on critical opportunities.

Business Scenario 2

Emily Modi, a Siebel Professional Services engagement manager, receives a call 
from a prospective customer. The prospective customer is interested in having 
Siebel Professional Services work on an opportunity. Emily enters the information 
about the project to help her understand and track the customer’s business 
problems. She qualifies the project opportunity and enters project specific 
information such as the planned start and end date, a description, resource 
requirements, and whether the project is billable or not.
2-2 Siebel Projects User Guide MidMarket Edition Version 7.0
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Opportunity Management Business Process 2

Figure 2-1. Opportunity Management Business Process
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Opportunities 2

Opportunity Management records and tracks information relating to opportunities 
in the views of the Opportunities screen. 

Managing Opportunities 2

You can access different Opportunities screen views to:

■ View your own opportunities with information that may include contacts, 
activities, products, competitors, estimated revenue, probability of closure, and 
sales stage.

■ View opportunities in the database.

■ Enter information about new opportunities.

■ Track the status of an opportunity through the sales cycle from creation to 
closure.

■ Update information about opportunities as they move through the sales cycle.

Creating Opportunities 2

Every time you identify an opportunity, you will want to create a new record.

To create a new opportunity

1 Navigate to the Opportunities screen.

2 From the Show drop-down list, select My Opportunities.

3 In the Opportunities list, click New.

4 In the new row, complete the necessary fields.

5 Click Save.
2-4 Siebel Projects User Guide MidMarket Edition Version 7.0
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Associating a Project with an Opportunity 2

Associating projects with an opportunity is critical to guarantee that sales 
representatives are collaborating with the proper professional services personnel to 
jointly develop and scope out the project to assure properly calibrated customer 
expectation.

To associate a project with an opportunity

1 Navigate to the Opportunities screen.

2 From the Show drop-down list, select My Opportunities.

3 In the Opportunities list, select the opportunity with which the project will be 
associated.

4 Click the Projects view tab.

5 In the Projects list, click the menu button and then click New Record.

6 In the new row, complete the necessary fields and then click Save.

NOTE: From this screen you will be able to add a new project but you will not be 
able to select a project.

Associating an Account to an Opportunity 2

Accounts will be a source of business for your company. An opportunity is a 
potential revenue-generating event and is another type of information that you can 
use to manage your accounts within the application.

To add an account to an opportunity

1 Navigate to the Accounts screen.

2 From the Show drop-down list, select My Accounts.

3 In the Accounts list, select the account to which the opportunity will be added.

4 Click the Opportunities view tab.
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5 In the Opportunities list, click New.

6 In the new row, complete the necessary fields and click Save.

NOTE: Sales stage selections are based upon the sales methods chosen by each 
individual organization.

Opportunity Contacts 2

As you work with an opportunity, contacts associated with the opportunity become 
increasingly important.

The Contacts view on the Opportunity screen allows you to track contact 
information obtained during the prospecting stage.

To add a contact to an opportunity

1 Navigate to the Opportunities screen.

2 From the Show drop-down list, select My Opportunities.

3 In the Opportunities list, select the opportunity to which a contact will be added.

4 Click the Contacts view tab.

5 In the Contacts list, click New.

6 From the Add Contacts dialog box, select the contact or contacts you want to add 
and then click OK. 

7 Click the menu button and then click Save Record.

NOTE: You can see how contacts are related to each other organizationally in the 
organizational analysis view.
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Organization Analysis 2

Knowing which products to sell is important; however, knowing who the decision 
makers are is just as important. They are the people who actually have the authority 
to make the purchase.

Organization charts are automatically created for each opportunity based on contact 
information for the opportunity. As contact information changes, the organization 
chart will immediately reflect the changes.

To add to the organization analysis

1 Navigate to the Opportunities screen.

2 From the Show drop-down list, select My Opportunities.

3 In the Opportunities list, select the opportunity with which the analysis will be 
created.

4 Click the Organization Analysis view tab.

5 In the Organization Analysis view, from the Show drop-down list, select 
Contacts.

6 In the Contacts list, click the menu button and then click New Record.

7 In the Add Contacts dialog box, select the contact or contacts you wish to add.

NOTE: You can select multiple contacts by holding down the shift key while 
selecting the contact records.

8 In the Contacts list, click the menu button and then click Edit Record.

9 In the Organization Analysis form, in the Manager Last Name field, click the 
select button.

10 In the Pick Manager dialog box, select the manager and click OK.

11 Click the Level of Influencer drop-down list and select the level and then click 
Save.

NOTE: The Manager Last Name and Level of Influencer fields need to be completed 
in order for the Organizational Analysis view to appear properly.
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To view the Organizational Analysis

■ In the Contacts list, from the Show drop-down list, select Organizational 
Analysis.

An Organizational chart appears with the contact information you entered.
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Project Management Overview 3

Project management is the process of:

■ Tracking tasks

■ Associating sub-tasks

■ Activities

■ Attachments to a project

■ Tracking the status and appropriate progress of the project

■ Generating project status reports for management purposes

■ Administering risks that may potentially affect the outcome of the project

■ Tracking and approving time, expense
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Project Management Business Process 3

Figure 3-1. Project Management Business Process
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Business Scenario 3

Emily Modi, an engagement manager, has been given the task of performing a 
global rollout and implementation for Marriott International. She is now in the 
process of determining the tasks or milestones that need to be completed for have 
a successful and profitable project. Because Emily has previously done several 
implementation projects, she knows there are several milestones that must be met. 
Emily knows that she needs to enter activities for this project and assign milestones 
to people on the team.

At this point, Emily breaks each milestone down to its component parts by 
associating tasks and activities. After creating her team workbook and securing the 
project delivery resources, Emily assigns the tasks and activities. She can use the 
tasks view to assign tasks and set expected completion dates. She is attempting to 
build the skeletal project plan that she will later export to Microsoft Project. By 
assigning tasks and activities, Emily can give the other members of her team an idea 
of the work each will do on the project. 

As Emily’s team members complete their tasks and activities, they can attach write-
ups and diagrams as necessary. Because these files are embedded in the Siebel 
application, anyone on the team can open the files and review the work to be done 
on the project.
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You can create projects in three different areas:

■ Projects. As a practice or project manager, you can view and manage your 
projects from this screen.

■ Opportunities. As a sales representative, you may want to create a project and fill 
in the preliminary information as it associates with the opportunity.

■ Accounts. As an account manager, you may want to create a project as it pertains 
to an account or view. 

Creating a New Project Using the Projects Screen 3

Practice managers are responsibilities for creating new projects and associating the 
relevant information to them.

To create a new project

1 Navigate to the Projects screen.

2 From the Show drop-down list, select My Projects.

3 In the Projects list, click the menu button and then click New Record.

4 In the Projects list, complete the necessary fields and then click Save.

Monitoring Your Team’s Projects 3

Another responsibility you have is to monitor your team’s projects. This gives you 
insight to the status of projects.

To monitor your team’s projects

1 Navigate to the Projects screen.

2 From the Show drop-down list, select My Team’s Projects.

3 In the Projects list, drill down on the Name hyperlink.

NOTE: Managers will be able to approve time sheets and expense reports that are 
submitted to them through the My Team’s filter.
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Associating an Account with a Project 3

While creating a new project, it is important to associate an account with it.

To associate an account with a project

1 Navigate to the Projects screen.

2 From the Show drop-down list, select My Projects.

3 In the Projects list, select the project with which the account will be associated.

4 In the Projects list, select the Account field and click the select button.

5 From the Pick Account dialog box, select the account and click OK.

6 In the Projects form, click Save.

Associating a Rate List with a Project 3

While you are creating a new project, it is important to associate it with a rate list. 
The rate list will automatically be related to a cost list. These two list will allow you 
to calculate your project resource margins in the Team Workbook.

To associate a rate list with a project

1 Navigate to the Projects screen.

2 From the Show drop-down list, select My Projects.

3 In the Projects list, select the project with which the rate list will be associated.

4 In the More Info form, from the Rate List drop-down list, select the appropriate 
rate.

5 Click Save.
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Associating an Opportunity with a Project 3

While you are creating a new project, it is important to associate an opportunity 
with it.

To associate an opportunity with a project

1 Navigate to the Projects screen.

2 From the Show drop-down list, select My Projects.

3 In the Projects list, select the project with which the opportunity will be 
associated.

4 In the More Info form, in the opportunity field, click the select button.

5 In the Pick Opportunity dialog box, select the opportunity and then click OK.

6 Click Save.

Creating a New Project Using the Opportunities Screen 3

The first step in tracking projects is to create new ones. Once you create projects 
you can then monitor their progress.

To create a new project

1 Navigate to the Opportunities screen.

2 From the Show drop-down list, select My Opportunities.

3 In the Opportunities list, select the opportunity with which the project will be 
associated.

4 Click the Projects view tab.

5 In the Projects list, click the menu button and then click New Record.

6 In the new row, complete the necessary fields and then click Save.
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Creating a New Project Using the Accounts Screen 3

The first step in tracking projects is to create new ones. Once you create projects, 
you can then monitor their progress.

To create a new project

1 Navigate to the Accounts screen.

2 From the Show drop-down list, select My Accounts.

3 In the Accounts list, select the account with which the project will be associated.

4 Click the Projects view tab.

5 In the Projects list, click the menu button and then click New Record.

6 In the new row, complete the necessary fields and then click Save.

Attaching a File to the Project 3

You can associate any attachment with a project. This is a repository that allows you 
to store and associate related data to a project. This keeps everyone involved in the 
project informed. 

To attach a file

1 Navigate to the Projects screen.

2 From the Show drop-down list, select My Projects.

3 In the Projects list, select the project to which the file will be attached.

4 Click the Attachments view tab.

5 In the Attachments list, click the menu button and then click New Record.

6 In the Attachment Name field, click the select button.

7 In the Add Attachment dialog box, click Browse.

8 In the Choose File dialog box, select the file to attach, click Open and then click 
Add. 

9 In the Attachments list, click Save.
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Associating Contacts with a Project 3

You want to associate contacts with a project. Contacts is a repository that allows 
you to associate every contact related to a project. This keeps everyone on the 
project informed. 

To associate a contact

1 Navigate to the Projects screen.

2 From the Show drop-down list, select My Projects.

3 In the Projects list, select the project with which the contact will be added.

4 In the Project list, drill down on the Name hyperlink.

5 In the Contacts list, click the menu button and then click New Record.

6 In the Add Contacts dialog box, select the contact or contacts you wish to add 
and then click OK.

NOTE: You can select multiple contacts by holding down the shift key while 
selecting the contact records.

Providing Access to a Project 3

You will most likely want different team members to see only their team’s projects. 
Only people on the access list have access to the projects.

To grant access to a project

1 Navigate to the Projects screen.

2 From the Show drop-down list, select My Projects.

3 In the Projects list, select the project to which the access will be granted.

4 Click the Access view tab.

5 In the Access list, click the menu button and then click New Record.
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6 In the Add Employees dialog box, select the employee or employees who should 
have access to this project and then click OK.

NOTE: You can select multiple employees by holding down the shift key while 
selecting the employee records.

7 In the Access list, click Save.

Adding Subcontractors 3

You want to associate subcontractors with your project, as well as make them 
available as part of your project team. 

To add subcontractor information

1 Navigate to the Projects screen.

2 From the Show drop-down list, select All Projects.

3 In the Projects list, select the project with which the subcontractor will be 
associated.

4 Click the Subcontractors view tab.

5 In the Subcontractors list, click the menu button and then click New Record.

6 In the Account Name field, click the select button.

7 In the Pick Account dialog box, select the account and then click OK.

8 Click Save.

To associate a subcontractor resource with a project

1 In the Subcontractors list, drill down on the Account Name hyperlink.

2 In the Resources list, click the menu button and then click New Record.

3 In the Role field, select a role from the drop-down list.

4 In the new row, complete the necessary fields and then click Save.

5 In the Contacts list, click Save.
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Querying for Qualified Resources for Your Project 3

Once a project has been created and you have estimated your resource needs, you 
can search for and add resources to the project team. You are now working on 
staffing your project.

A simple, but powerful, way to find qualified resources is to query on a desired skill 
in the Employees Query view.

NOTE: You can set up more skills in Tools, MidMarket Edition. For more information, 
see Siebel Tools Reference, MidMarket Edition.

To query for resources

1 From the application-level menu, choose Site Map > User Administration > 
Employees.

2 Click the Employee Query view tab.

3 In the Employee Query Skill list, select the skill.

4 In the Employee Query list, click Query.

5 In the Expertise field, from the drop-down list, select an expertise.

6 Click Go.

Use the Employee Query list to help locate the resource that fits the skills 
requirements for the project.

7 Once an employee has been located, click the Employee Availability view tab to 
check their availability.

8 Based on the information in Step 6, write down the name of the resource so that 
you can add it to the team workbook.
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If you do not have access to your team’s Microsoft Project template, but still need 
to scope out your project, you can use the Activity Plans view to lay out your project 
parameters and then build your project details. Activity plans provide a set of 
prebuilt templates just like Microsoft Project. The template rolls out a collection of 
activities in a logical order based on the start date specified. You can also create 
activities without the aid of activity plans or Microsoft Project.

To create activities using activity plans

1 Navigate to the Projects screen.

2 From the Show drop-down list, select My Projects.

3 In the Projects list, select the project with which the activities will be associated.

4 Click the Activity Plans view tab.

5 In the Activity Plans list, click the menu button and then click New Record.

6 In the Template field, select a template from the drop-down list and click Save.

The activities associated with the Activity plan appears in the Activities list 
subview.

To create activities manually

1 Navigate to the Projects screen.

2 From the Show drop-down list, select My Projects.

3 In the Projects list, select the project with which the activities will be associated.

4 Click the Activities view tab.

5 In the Activities list, click the menu button and then click New Record.

6 In the Activities list, complete the necessary fields and then click Save.
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Creating Tasks Manually 3

After you have added the necessary activities, you may want to group them in a 
logical pattern using tasks. Tasks are basically containers for groups of related 
activities.

To create tasks manually

1 Navigate to the Projects screen.

2 From the Show drop-down list, select My Team’s Projects.

3 In the Projects list, select the project with which the tasks will be associated.

4 Click the Tasks view tab.

5 In the Tasks list, click the menu button and then click New Record.

6 In the new row, complete the necessary fields and then click Save.

To associate activities to tasks

1 Navigate to the Projects screen.

2 From the Show drop-down list, select My Team’s Projects.

3 In the Projects list, select the project with which the tasks will be associated.

4 Click the Tasks view tab.

5 In the Tasks list, drill down on the Name hyperlink.

6 In the Activities list, click the menu button and then click New Record.

7 In the Activities list, complete the necessary fields and then click Save.
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Tasks and Activities 3

If you are importing Microsoft Project files to create tasks and activities and they 
imported successfully, you can take a look at associated tasks and activities.

To view tasks

1 Navigate to the Projects screen.

2 From the Show drop-down list, select My Projects.

3 In the Projects list, select the project with which the tasks are associated.

4 Click the Tasks view tab.

A listing of all imported tasks appears.

To view activities

1 Navigate to the Projects screen.

2 From the Show drop-down list, select My Projects.

3 In the Projects list, select the project with which the activities are associated.

4 Click the Activities view tab.

A listing of all imported activities appears.

NOTE: For more information on how to import Microsoft Project file, refer to 
Chapter 4, “Microsoft Project Integration.”
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Assessing Risks for a Project 3

One of the biggest project management challenges you will face is identifying and 
managing risk items. You can identify and quantify risk items early in the 
opportunity phase. This has several advantages, it allows you to price in the 
appropriate risk premium or discounts, and it gives you and the customer a clear 
understanding of the risks involved.

To create a risk

1 Navigate to the Projects screen.

2 From the Show drop-down list, select My Team’s Projects.

The Projects list appears.

3 In the Projects list, select the project to which the risks will be associated.

4 Click the Risks view tab.

5 In the Risks list, click the menu button and then click New Record.

6 In the new row, complete the necessary fields and click Save.

NOTE: Repeat Step 5 and Step 6 until every risk has been added to the project. Each 
risk item can be tracked and reported in the status report.

To create risk resolution activities

1 Navigate to the Projects screen.

2 From the Show drop-down list, select My Team’s Projects.

The Projects list appears.

3 In the Projects list, select the project to which the risks will be associated.

4 Click the Risks view tab.

5 In the Risks list, drill down on the Name hyperlink.

6 In the Resolution Activities list, click the menu button and then click New 
Record.

7 In the new row, complete the necessary fields and then click Save.
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Creating a Status Report for a Project 3

You may want to create a project status report summarizing the project’s progress, 
forecast, and issues. You can incorporate any project risk issues into your status 
report.

To create a status report

1 Navigate to the Projects screen.

2 From the Show drop-down list, select My Projects.

3 In the Projects list, select the project with which the status report will be 
associated.

4 Click the Status Report view tab.

5 In the Status Report list, click the menu button and then click New Record.

6 In the new row, complete the necessary fields and then click Save.

To associate risk issues with a status report

1 Navigate to the Projects screen.

2 From the Show drop-down list, select My Projects.

3 In the Projects list, select the project with which the status report will be 
associated.

4 Click the Status Report view tab.

5 In the Project Status Item subview list, click the menu button and then click New 
Record.

6 Click the Type drop-down list and select a risk.

7 In the Project Status Item subview list, complete the necessary fields and then 
click Save.

NOTE: Repeat Step 5 through Step 7 until you have added every risk item. 
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Team Workbook 3

When staffing a project, the project manager tracks the number of people needed 
on the team and the roles they will play. The team workbook helps managers create 
team scenarios, estimate the number of people and types of resources needed to 
staff the project, and manage overall resource needs of the project.

Organizing the Project Staff 3

You will organize your projecting using the Team Workbook. Those tasks are as 
follows:

1 Estimating Resource Needs

2 Setting Project Rates and Schedules

3 Identify Resource Need Dates, Skills and Competencies requirements in the 
Team Workbooks view

4 Overall Project Resource Management

Figure 3-2. Team Workbooks View
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Setting Up a Project Team Workbook 3

The Team Workbook maintains resource information for the project. It identifies 
required roles, skills, and competencies associated with those roles as well as time 
commitments.

To identify roles for the team workbook

1 Navigate to the Projects screen.

2 From the Show drop-down list, select My Projects.

3 In the Projects list, select the project with which the Team Workbook will be 
associated.

4 Click the Team Workbook view tab.

5 In the Team Workbook list, click the menu button and then click New Record.

6 In the new row, complete the necessary fields and then click Save.

NOTE: It is very important that you complete the Role and Start/End Date fields. 
Repeat Step 5 and Step 6 until you have added every role. 

Adding Skills and Competencies 3

After you have added a role to the Team Workbook, you will want to associate skills 
and competencies with that role. This is also an easy way of assigning people and 
populating their positions through the team workbook.

To add skills 

1 Navigate to the Projects screen.

2 From the Show drop-down list, select My Projects.

3 In the Projects list, select the project with which the Team Workbook will be 
associated.

4 Click the Team Workbook view tab.

5 In the Team Workbook list, select the role to which the skills will be added.
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6 In the Skills subview list, click the menu button and then click New Record.

7 In the new row, select a skill from the skill drop-down list and then click Save.

NOTE: Repeat Step 5 on page 3-18 through Step 7 for each new skill.

To add competencies

1 Navigate to the Projects screen.

2 From the Show drop-down list, select My Projects.

3 In the Projects list, select the project with which the Team Workbook will be 
associated.

4 Click the Team Workbook view tab.

5 In the Team Workbook list, select the role to which competencies will be added.

6 In the Skills list, select the skill to which the competencies will be added.

7 In the Competencies subview list, click the menu button and then click New 
Record.

8 In the new row, select a Language Code and Expertise Level from the drop-down 
list and then click Save.

NOTE: Repeat Step 5 through Step 8 for each new competency.
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Microsoft Project Integration Overview 4

Microsoft Project Integration allows team leaders to track tasks and activities and to 
share them with their project team. Team members can view their assigned 
activities and update the status on these activities. They can also include these 
activities in their time sheets and expense reports automatically. Team leaders can 
import activity and requirement status to their Microsoft Project to make sure the 
plan is up to date and can use Microsoft Project’s tools to modify their project plan. 
Partners and team leaders can access project status to gain an immediate insight on 
a project’s status, requirement completion, and cost.

Business Scenario 4

Emily Modi, the engagement manager, may choose to use Microsoft Project to 
initially outline and define projects. A typical project outline during the project 
definition phase may include major milestones, due dates, deadline, key tasks, and 
work breakdown structures (WBS).

After the project has been defined in Microsoft Project, the project can be imported 
from a Microsoft Project file into the Siebel application and resource assignments 
can be made to the project. By using plan integration, the project manager can 
select a data map to import the necessary project information from Microsoft Project 
into the Siebel application.

When initiating a project, a project manager may choose to export project 
information back to Microsoft Project from the Siebel application to reflect updates, 
such as percent complete or resource assignments. By using plan integration, the 
project manager can select a data map and apply an export filter to export the 
necessary project information to Microsoft Project.
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There are five Mapping Templates you can use from when preparing to import or 
export your Microsoft Project information into your Siebel application. They are:

■ Resources Only. This template imports Microsoft Project resources into the 
Projects screen, Team Workbook view as Siebel roles. 

■ Activities Only. This template imports Microsoft Project tasks and summary tasks 
into the Projects screen, Activities view as Siebel activities. 

■ Standard. This template imports Microsoft Project resources into the Projects 
screen, Team Workbooks view as Siebel roles. It also imports Microsoft Project 
tasks into the Projects screen, Activities view as Siebel activities and Microsoft 
Project summary tasks into the Projects screen, Tasks view as Siebel tasks.

■ Tasks Only. This template imports Microsoft Project tasks and summary tasks 
into the Projects screen, Tasks view as Siebel tasks.

■ Tasks and Activities Only. This template imports Microsoft Project tasks into the 
Projects screen, Activities as Siebel activities and Microsoft Project summary 
tasks into the Projects screen, Tasks view as Siebel tasks.

Mapping Filters—Exporting 4

In addition to the mapping templates, Siebel provides four filters that can be applied 
to the export maps to further refine the data being imported. They are:

■ Activity Resource Filter. This allows for the import of specific resource activities. 
For example, import each activity associated with John Smith.

■ Activity Type Filter. This allows for the import of a specific type of activity. For 
example, import each activity with the type equal to milestone.

■ Task Resource Filter. This allows for the import of specific resource types. For 
example, import each task associated with John Smith.

■ Task Type Filter. This allows for the import of a specific type of task. For example, 
import each task with the type equal to deliverable.
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Figure 4-1. Microsoft Project Business Process
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Plan integration allows you to exchange data from Microsoft Project files using 
many different prebuilt data maps. Customers can also build their own data maps 
using the Project Mapping function. The data exchange process is intuitive and 
allows users to reuse a project’s best practices and knowledge.

To create a new plan integration to import a Microsoft Project file

1 Navigate to the Projects screen.

2 From the Show drop-down list, select My Projects.

3 In the Projects list, select the project to which the file will be exchanged.

4 Click the Plan Integration view tab.

5 In the Plan Integration list, click the menu button and then click New Record.

6 In the Attachment Name field, click the select button.

7 In the Add Attachment dialog box, click Browse.

8 In the Choose File dialog box, select the Microsoft Project file that you want to 
import and click Open.

9 In the Add Attachment dialog box, click Add.

10 In the Plan Integration list, in the Mapping Template field, click the select 
button.

11 In the Pick Microsoft Project Mapping dialog box, select the data exchange map 
that you want to use and then click OK.

12 Click Save.

13 In the Plan Integration list, click Import.
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To create a new plan integration to export to a Microsoft Project file

1 Navigate to the Projects screen.

2 From the Show drop-down list, select My Projects.

3 In the Projects list, select the project to which the file will be exchanged.

4 Click the Plan Integration view tab.

5 In the Plan Integration list, click the menu button and then click New Record.

6 In the Attachment Name field, click the select button.

7 In the Add Attachment dialog box, click Browse.

8 In the Choose File dialog box, select the Microsoft Project file that you want to 
export and click Open.

9 In the Add Attachment dialog box, click Add.

10 In the Plan Integration list, in the Mapping Template field, click the select 
button.

11 In the Pick Microsoft Project Mapping dialog box, select the data exchange map 
that you want to use and then click OK.

12 Click Save.

13 In the Activity Filter and Task Filter fields, click the select button.

14 In the Filter dialog box, select the filters you want to use and then click Save.

15 In the Plan Integration list, click Export.
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During the delivery of a project, you may decide to exchange project information 
between your Siebel application and Microsoft Project. Typically, a project is created 
in Microsoft Project and imported into the Siebel application for resource 
assignment or time and expense entries. After resource assignments have been 
made and time and expense entries collected, project data is exported to Microsoft 
Project for rescheduling and progress updates.

Several important contraints need to be considered when importing or exporting 
Microsoft Project data into or out of your Siebel application. They are:

■ List of Values. (LOVs) These must be reflected identically in Microsoft Project.

■ Resources. Resources in Microsoft Project must be reflected in Siebel’s employee 
list.

■ Configuration. Not all fields in Microsoft Project can be imported or exported 
without configuration in Siebel Tools.

NOTE: For additional information on importing or exporting data between Microsoft 
Project and your Siebel application, refer to the Data Administration and Project 
Mapping section in Applications Administration Guide, MidMarket Edition. 
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Proper use of a person’s time is one of the most important metrics. More and more 
customers require detailed time reporting to help detect and eliminate inefficiencies. 
Time Sheets tracks time units of activities performed, allowing management to 
better understand when work on each activity has been completed and therefore 
allows them to adjust resource scheduling to help keep projects and tasks on target. 
With time sheets sales managers will be able to measure the cost of sales, call center 
managers will have better insight into where the call center agents are spending 
their time, customer service agents can track different classes of time on an activity, 
and professional services managers can track the actual time spent versus the 
budgeted time on an activity or task.
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Payton Singh, a consultant at Siebel Global Services, shows up for work on Monday 
morning and reviews the tasks he is assigned for the day in the My Activities filters 
of the Activities screen. He takes a closer look at the tasks due today and early in 
the week and begins work on his first task. 

As Payton works on each activity throughout the day, he logs the number of hours 
or minutes spent as individual records associated to the activity. Payton can track 
the individual time units he works on each activity and can have the total time for 
the activity automatically aggregated to the duration field of the activity. Each one 
of the time tracking records can be marked as billable and can be included on his 
time sheet. Payton may also have some time to spend on an activity that is not billed 
to the customer, but may be included on the time sheet to account for his time.

At the end of the week, it is time for Payton to create and submit his time sheet. He 
can click Auto Time Sheet and a time sheet is automatically created for him based 
on time records that have been entered for his activities. He then navigates to the 
newly created time sheet and drills down on the Name field to get the Line Items 
view. There he will see a list of the days included for the time sheet along with time 
details that make up the billable and non-billable totals for that day.

Upon completing the review of his time sheet, Payton set the status of the time sheet 
to Submitted and he is sure his manager will see the submitted sheet in the 
Approvals view.

Payton’s manager, Emily, goes to the Time Sheet Approval filter to see which time 
sheets have been submitted. She locates Payton’s time sheet and after looking at the 
details, Emily approves the time sheet and the time sheet is now ready to go to the 
billing department.
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Figure 5-1. Time Sheets Business Process
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Time sheets allow users to associate time entered with a specific project.

Creating Time Sheets 5

To create a time sheet 

1 Navigate to the Time Sheets screen.

2 From the Show drop-down list, select My Time Sheets.

3 In the Time Sheets list, click the menu button and then click New Record.

4 In the new row, complete the necessary fields and then click Save.

NOTE: Although defaults are chosen for various fields, the user can override 
these defaults in the Line Items view.

Daily Hours 5

After a time sheet has been created, you will need to update the hours spent on your 
various projects so that the appropriate charges can be accessed back to the 
customer.

To input daily hours into a time sheet

1 Navigate to the Time Sheets screen.

2 From the Show drop-down list, select My Time Sheets.

3 In the Time Sheets list, select the time sheet with which hours will be associated.

4 Drill down on the Name hyperlink.

The Line Items, Daily Hours, and Unreported Time lists appear.

5 In the Line Items list, select the day with which hours will be associated.
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6 In the Daily Hours list, click the menu button and then click New Record.

7 In the Daily Hours list, report your hours, complete the necessary fields and then 
click Save.

NOTE: To add additional days and hours, repeat Step 5 on page 5-5 through 
Step 7 until you have entered all days and hours. The totals represented on the 
time sheet will reflect of both billable and nonbillable time.

Unreported Time 5

When filling out your daily hours, you have the option of not reporting time for 
charge back to the customer. Unreported time will show up in the Unreported Time 
list when you:

■ Do not run AutoGen, each item you have associated with an activity will appear 
under Unreported Items

■ Activity time falls outside the AutoGen period

To promote unreported time to daily hours

1 Navigate to the Time Sheets screen.

2 From the Show drop-down list, select My Time Sheets.

3 In the Time Sheets list, select the time sheet with which hours will be associated.

4 Drill down on the Name hyperlink.

The Line Items, Daily Hours, and Unreported Time lists appear.

5 In the Unreported Time list, select the item that will now be reported.
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6 Click the Add to Line button.

Time will be removed from the Unreported Time list and be added to the Daily 
Hours list.

NOTE: The totals that are represented on your timesheet reflect of both billable 
and nonbillable hours. Only the owner or the preparer will be able to see records 
in the Unreported Time list. Managers will be able to see the list but it will not 
display any records.

Activity Time 5

Siebel Projects tracks time down to the activity level. Within the Activities view, you 
can drill down on the activity and enter the appropriate time associated with that 
activity. The AutoGen feature is used to automatically populate entered data into 
the appropriate time sheet. This process significantly reduces unproductive time 
and guesswork.

To enter activity time

1 Navigate to the Activities screen.

2 From the Show drop-down list, select My Activities.

3 In the Activities list, select the activity with which the expenses will be added.

4 Click the Time view tab.

5 In the Time list, click the menu button then click New Record.

6 In the new row, complete the necessary fields and click Save.
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The automatic generation of time sheets gives you a way to track time while doing 
activity management through the Auto Time Sheet feature.

To create a time sheet automatically

1 Navigate to the Activities screen.

2 From the Show drop-down list, select My Activities.

3 In the Activities list, select the Activity with which the expenses will be 
associated.

4 Click on the Time view tab.

5 In the Time list, click the menu button and then click New Record.

6 In the new row, complete the necessary fields and then click Save.

7 From the application-level menu, choose File > Auto > Timesheet.

AutoGen is invoked and takes you to the Time Sheets screen where you can 
make additional edits in the More Info form if necessary.

AutoGen 5

For AutoGen to work properly, you must complete the time sheet with the time 
period reported plus 3 calendar days. Otherwise, you must input your information 
manually through the Time Sheets screen.

AutoGen will only add activity time items to a time sheet that has not been 
submitted, rejected, approved, or accepted. If a time sheet for the AutoGen period 
does not exist, AutoGen will create one. If a time sheet for the AutoGen period exists 
and is in the In Progress status, then AutoGen will add the line items into the time 
sheet.

For time sheet items that are created in activity time, but did not get captured by 
AutoGen, they will be displayed in the Unreported Items subview of the Report Line 
Items view.
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AutoGen Process 5

AutoGen works in the following manner:

■ It finds the current open time reporting period of type week.

■ It then checks to see if you have time report with a status of “In Progress” for 
the current period. If you do not have a report “In Progress,” you will want to 
create a new report and set the period to the current reporting period. 

■ It will then cycle through each day and associate the time line units with the 
appropriate day in the time sheet.

Submitting a Time Sheet 5

After a Time Sheet has been created and the line items added, you can edit it if 
necessary (as many times as needed) until you submit the time sheet. 

When an time sheet is submitted, it is automatically routed to the approver for 
evaluation. 

Each submitted report is either approved or rejected by the approver. If the report 
is accepted, it is routed to the financial department where the charges are sent by 
invoice to the customer for payment. The status will change to accepted. 

To submit a time sheet

1 Navigate to the Time Sheets screen.

2 From the Show drop-down list, select My Time Sheets.

The Time Sheets list appears.

3 In the More Info form, click the Status drop-down list and select Submitted and 
click Save.

If your time sheet is rejected, you need to go back into the Time Sheets screen, make 
the necessary changes, then resubmit it.

NOTE: The Submitted To, Owner and Prepare of a time sheet has the ability to 
change the Submit To field.
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To resubmit a time sheet

1 Navigate to the Time Sheets screen.

2 From the Show drop-down list, select My Time Sheets.

3 In the Time Sheets list, change the status field from Rejected to In Progress.

4 Click the Line Items view tab.

5 In the Line Items, Daily Hours, or Unreported Items lists, make the necessary 
changes and then click Save.

6 In the Detail form, click the Status drop-down list, select Submitted and then 
click Save.

Monitoring the Status 5

After you have submitted your time sheet, the application uses email to notify both 
you and your manager of its progress.

For example, when you submit your time sheet to your manager, the manager 
receives an email informing them that there is a time sheet waiting for approval. 

Likewise, when the manager has approved or rejected the time sheet, you receive 
email notification.

Another example is if you send your time sheet for approval, but your manager is 
out of the office, you are notified of this and you can go back into your time sheet 
and resubmit it to another manager.
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Printing a Time Sheet 5

You can print time sheets from the Reports menu.

To print a time sheet

1 Navigate to the Time Sheets screen.

2 From the Show drop-down list, select My Time Sheets.

3 In the Time Sheets list, locate the time sheet to which you wish to run the report.

4 From the application-level menu, choose View >Reports.

5 From the Reports dialog box, select Time Sheets from the drop-down list.

6 Click Run.

The application generates your time sheet.
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Approving Time Sheets 5

You are responsible, as a manager, to check your team’s time sheets and either 
approve or reject them based on the information.

To approve a time sheet

1 Navigate to the Time Sheets screen.

2 From the Show drop-down list, select Time Sheet Approval.

3 In the Time Sheets list, select the time sheet to approve.

4 In the Time Sheets list, click the Status drop-down arrow, and select Approved 
and then click Save.

NOTE: To reject a time sheet, follow the same instructions, except pick Rejected from 
the Status drop-down list.

Time Sheet Adjustment 5

As the manager, there may be times when a time sheet has been submitted but then 
needs adjustment. These adjustments are necessary so that the correct information 
is collected, processed, and billed adequately to the customer.

To make an time sheet adjustment

1 Navigate to the Projects screen.

2 In the Show drop-down list, select My Projects.

3 In the Projects list, select the project with which the time sheet was associated.

4 Click the Time & Expense view tab.

5 In the Time & Expense list, from the Show drop-down list, select Time 
Adjustments.

6 In the Time & Expense list, select the time sheet that needs to be adjusted.

7 In the Adjusted Hours field, click the select button.
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8 In the Adjusted Hours dialog box, click New.

9 In the Hours field, adjust the time as necessary and then click Save.

10 In the Adjusted Hours dialog box, click Close.

The Total Adjustment, Billable Hours, and Billable Amount fields are updated to 
reflect your adjustments.

Time Sheet Adjustments Chart 5

You can see a graphical representation of the adjustments made using the Time 
Sheet Adjustments chart.

You can also modify the way the data is represented by using the Show drop-down 
boxes to change the information.

You can also move the mouse over the different bars to get additional information 
on a particular employee.

Figure 5-2. Time Sheet Adjustment Chart
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Time Sheet Summary 5

The Time Sheet Summary view can give you an overall perspective of hours spent 
on a particular project.

To view time sheet summary information

1 Navigate to the Projects screen.

2 From the Show drop-down list, select My Projects.

3 In the Projects list, select the project with which time sheet information is 
associated.

4 Click the Time & Expenses view tab.

5 In the Time & Expense list, from the Show drop-down list, select Time Summary.

The information on the Time Summary list shows you the reported hours for 
each time sheet. To view additional information, drill down on the Time Sheet 
Name hyperlink.

Figure 5-3. Time Summary List
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Time Sheet Summary Chart 5

You can see a graphical representation of the cumulative hours worked on a project 
using the Time Sheet Summary Chart.

You can modify the way the data is represented by using the Show drop-down boxes 
to change the information.

You can move the mouse over the different bars to get additional information on 
hours logged by a particular employee.

Figure 5-4. Time Sheet Summary Chart
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Expense reporting helps you streamline the expense reimbursement process by 
eliminating the manual, error-prone, and time consuming task of completing the 
necessary forms. Expense reporting prepares expense reports electronically, which 
helps guarantee that you are reimbursed for your expenses. It also handles complex 
currency conversions to accommodate business needs that take you out of the 
country.

Business Scenario 6

Emily has finished her project at Marriott International and is back in her office 
waiting for her next assignment. Before being reassigned, however, Emily needs to 
complete an expense report for the business expenses she incurred at Marriott. By 
doing so, her company can bill back Emily’s materials, and Emily can get 
reimbursed for her expenses.

Emily will complete an expense report from her application for this project, and she 
can then submit it electronically to her manager for approval. Once approved, it can 
be routed to the finance department. Emily is reimbursed and Marriott International 
is charged for Emily’s services.
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Figure 6-1. Expense Reporting Business Process
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Expense reports allow you to:

■ Complete expense reports quickly and easily

■ Track expense in multiple currencies

■ Track the status of a submitted expense report

■ Capture special kinds of expenses such as hotel stays and mileage

■ Track the actual cost of a project

■ Streamline export to accounts payable for payment

Creating an Expense Reports 6

After incurring business expenses, you will want to complete and submit an 
expense report to get reimbursement for expenses incurred during your trip.

To create an expense report

1 Navigate to the Expense Reports screen.

2 From the Show drop-down list, select My Expense Reports.

3 In the Expense Reports list, click the menu button and then click New Record.

4 In the new row, complete the necessary fields and then click Save.

NOTE: You must complete the Submit To field or you will get an error message and 
your expense report will not be saved.
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Detailed Line Items 6

Each expense report must have at least one line item associated with it. Expense 
items (or the entire expense report) can be associated with an account, opportunity, 
project, or contact. Associating expense reports allows you to track expenses 
appropriately. For expense types such as dinner or entertainment, you can associate 
contacts and employees. For international travel, you can convert expense report 
items that include several currencies. 

To add detailed line items

1 Navigate to the Expense Reports screen.

2 From the Show drop-down list, select My Expenses.

3 In the Expense Reports list, locate the expense report with which the line items 
will be associated.

4 In the Expense Reports list, drill down on the Name hyperlink.

The Line Items list appears.

5 In the Line Items list, click the menu button and then click New Record.

6 In the new row, complete the necessary fields and then click Save.

NOTE: Repeat Step 5 and Step 6 until you have added every expense line items.

Hotel and Mileage Expenses 6

You can enter daily hotel and mileage expenses by drilling down on the Type 
hyperlink and entering the information.

To enter daily hotel expenses

1 Navigate to the Expense Reports screen.

2 From the Show drop-down list, select My Expense Reports.

3 In the Expense Reports list, drill down on the Name hyperlink.
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4 In the Line Items list, drill down on the Type hyperlink for Hotel. 

The Hotel Expenses list appears and the Details form appears.

5 In the Details form, click the menu button and then click New Record.

6 In the Details form, complete the necessary fields and then click Save.

NOTE: Repeat Step 5 and Step 6 until you have entered every hotel expense. 

To enter mileage expenses

1 Navigate to the Expense Reports screen.

2 From the Show drop-down list, select My Expense Reports.

3 In the Expense Reports list, drill down on the Name hyperlink.

4 In the Line Items list, drill down on the Type hyperlink for Mileage.

5 In the Details form, click the menu button and then click New Record.

6 In the Details form, complete the necessary fields and then click Save.

NOTE: Repeat Step 5 and Step 6 until you have entered every mileage expense. You 
only have the ability to drill down on the Hotel and Mileage hyperlinks.

Unreported Items 6

When filling out the detailed line items, you have the option of not reporting some 
items for reimbursement. 

To set an item as unreported

1 Navigate to the Expense Reports screen.

2 From the Show drop-down list, select My Expenses.

3 In the Expense Reports list, locate the expense report to which the line items will 
be associated.
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4 Drill down on the Name hyperlink.

The Line Items list appears.

5 In the Line Items list, click the menu button, and then click New Record.

6 In the new row, complete the necessary fields and then click Save.

7 In the Line Items list, select the item or items that you want to unreport and then 
click Unreport.

The item or items that you select are removed from the Expense Report list and 
now show up on the Unreported Items list.

NOTE: The totals that are represented on your expense report reflect both billable 
and nonbillable hours. Only the owner or the prepare will be able to see records in 
the Unreported Items list. Managers will be able to see the list but it will not display 
any records.
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Auto Expense Reporting 6

You can also use the Auto Gen feature to automatically populate entered data into 
the appropriate expense report. This automated process significantly reduces 
unproductive time and guesswork.

To use AutoGen

1 Navigate to the Activities screen.

2 From the Show drop-down list, select My Activities.

3 In the Activities list, select the Activity with which the expenses will be 
associated.

4 Click on the Expenses view tab.

5 In the Expenses list, click the menu button and then click New Record.

6 In the new row, complete the necessary fields, click Save.

7 From the application-level menu, choose File >Auto >Expenses.

AutoGen is invoked and takes you to the Expense Reports screen where you can 
make additional edits in the More Info form if necessary.

NOTE: You do not need to be in a particular screen for AutoGen to work. You can 
use AutoGen from any screen in the application. Above is one example of a screen 
where it can be used.

AutoGen 6

For AutoGen to work properly, you must complete the expense report for the time 
period reported plus three calendar days. Otherwise, you must input your 
information manually through the Expense Reports screen. 

AutoGen will only add activity expense items to an expense report that has not been 
submitted, rejected, approved, or accepted. If an expense report for the AutoGen 
period doesn’t exist, AutoGen will create one. If an expense report for the AutoGen 
period exists and is in the In Progress status, then AutoGen will add the line items 
into the expense report.

For expense items that are created in activity expense, but did not get captured by 
AutoGen, they will be displayed in the Unreported Items subview of the Report Line 
Items view.
6-8 Siebel Projects User Guide MidMarket Edition Version 7.0



Expense Reporting

Expense Reports
AutoGen Process 6

AutoGen works in the following manner:

■ It finds the current open expense or time reporting period of type week.

■ It then checks to see if you have an expense report with a status of “In Progress” 
for the current period. If you do not have a report “In Progress,” you will want 
to create a new report and set the period to the current reporting period. 

■ It will then find the expenses with a start date which falls within the start and 
end dates of the current period and associate them to the expense report for that 
period.

Foreign Currency 6

If you incur expenses from a foreign country, the application allows you to establish 
a currency type specific to that country. 

To change the default currency code

1 Navigate to the Expense Reports screen.

2 From the Show drop-down list, select My Expense Reports.

3 In the More Info form, Currency field, click the select button.

4 In the Pick Currency Code dialog box, select the currency and then click OK.

5 Click Save.
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Cash Advances 6

You can enter Cash advances in the Cash Advance field on the More Info form. The 
amount is subtracted from the total amount owed to you.

To enter cash advance information

■ In the Cash Advance field, enter the amount you received as a cash advance.

NOTE: You can also use the select button.

Submitting an Expense Report 6

After an expense report has been created and the line items added, you can edit it 
if necessary (as many times as needed) until you submit the expense report. 

When you submit an expense report, the application automatically routes it to your 
manager for evaluation. If the expense report needs to be submitted to someone 
other than your manager (such as the team leader or project manager), click the 
Submit To button and select the person from the Pick Employee dialog box.

Each submitted report is either approved or rejected by the manager. If the manager 
accepts the report, it is routed to the financial department, and the employee is 
reimbursed for the amount requested. The status of the report changes to accepted. 

To submit an expense report

1 Navigate to the Expense Report screen.

2 From the Show drop-down list, select My Expense Reports.

The Expense Reports list appears.
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3 In the More Info view, click the Status drop-down arrow and select submitted.

4 Click Save.

If your expense report is rejected, you need to go back into the Expense Reports 
screen, make the necessary changes, and then resubmit it.

NOTE: The Submitted To, Owner and Prepare of an expense report has the ability to 
change the Submit To field.

To resubmit an expense report

1 Navigate to the Expense Reports screen.

2 From the Show drop-down list, select My Expense Reports.

3 In the Expense Reports list, change the status field from Rejected to In Progress.

4 Click the Line Items view tab.

5 In the Line Items list make the necessary changes, click Save.

6 In the Expense form, click the Status drop-down list and select Submitted and 
then click Save.

Monitoring the Status of an Expense Report 6

After you have submitted your expense report, the application uses email to notify 
both you and your manager of its progress.

For example, when you submit your expense report to your manager, the manager 
receives an email notification that there is a time sheet waiting for approval. 

Likewise, when the manager has approved or rejected the expense report, you will 
receive email notification. 

Another example of this process is when you send your expense report for approval 
but your manager is out of the office. In this situation, you are notified so that you 
can go back into your expense report and resubmit it to another manager.
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Printing an Expense Report 6

You can print expense reports from the Reports menu.

To print an expense report

1 Navigate to the Expense Report screen.

2 From the Show drop-down list, select My Expense Reports.

3 In the Expense Reports list, locate the expense report to which you wish to run 
the report.

4 From the application-level menu, choose View > Reports.

5 In the Reports dialog box, select expense reports from the drop down list.

6 Click Run.

The application generates your expense report. 
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Approving Expense Reports 6

It is your responsibility, as a manager, to check your Team’s expense reports and 
either approve or reject them based on the information in the report.

To approve an expense report

1 Navigate to the Expense Report screen.

2 From the Show drop-down list, select Expense Report Approval.

3 In the Expense Report list, select the expense report to approve.

4 In the Expense Report list, click the Status drop-down arrow, and select 
Approved.

5 Click Save.

NOTE: To reject a time sheet, follow the same instructions, except pick Rejected from 
the Status drop-down list.

Expense Reports Adjustment 6

There may be times, as a manager, when you received an expense report but it 
needs to be adjusted, these adjustments are necessary so that the correct 
information is collected, processed, and billed appropriately to the customer.

To make an expense reports adjustment

1 Navigate to the Projects screen.

2 In the Show drop-down list, select My Projects.

3 In the Projects list, select the project with which the expense report was 
associated.

4 Click the Time & Expense view tab.

5 In the Time & Expense list, from the Show drop-down list, select Expense 
Adjustment.

6 In the Time & Expense list, select the expense report that needs to be adjusted.
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7 In the Adjustment field, click the select button.

8 In the Adjusted Amount dialog box, click New.

9 In the Amount field adjust the amount as necessary, and then click Save.

10 In the Adjusted Amount dialog box, click Close.

The Total Adjustment and Billable Total fields are updated to reflect your 
adjustments.

Expense Adjustments Chart 6

You can see a graphical representation of the adjustments made using the Expense 
Adjustments chart.

You can modify the way the data is represented by using the Show drop-down boxes 
to change the information.

You can move the mouse over the different bars to get additional information on a 
particular employee.

Figure 6-2. Expense Adjustment Chart
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Expense Report Summary 6

The Expense Report Summary view will give you an overall perspective of expenses 
incurred on a particular projects.

To view expense report summary information

1 Navigate to the Projects screen.

2 From the Show drop-down list, select My Projects.

3 In the Projects list, select the project with which time sheet information is 
associated.

4 Click the Time & Expenses view tab.

5 In the Time & Expense list, from the Show drop-down list, select Expense 
Summary.

The information displayed on the Expense Summary list shows you the reported 
expenses per expense report. To view additional information, drill down on the 
Expense Report Name hyperlink.
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Expense Summary Chart 6

You can see a graphical representation of the cumulative expense incurred on a 
project using the Expense Summary Chart.

You can modify the way the data is represented by using the Show drop-down boxes 
to change the information.

You can move the mouse over the different bars to get additional information on 
hours logged by a particular employee.

Figure 6-3. Expense Summary Chart
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Financials Overview 7

Tight integration with back office systems allows your organization to take project, 
time and expense data from the Siebel Projects in order to create client invoices and 
track accounts receivable in their billing system of choice. 

Business Scenario 7

Emily Modi is the primary engagement manager associated with a new project. She 
is responsible for the project’s primary revenue value. Initially, this revenue amount 
for the project may be determined by early conversations with the client about 
scope, budget, and other high-level parameters. As the project progresses, she 
gathers greater knowledge of the customer’s needs. Using this information, Emily 
can determine which product solution best addresses the client’s business 
problems. 

At this point, she enters various product lines. This helps her assess the value of the 
project. Emily can easily see any adjustments made to the revenue line items. She 
uses her expertise to adequately assess the value of the project by querying on only 
those items she finds most relevant to the project. 

Once a week, Emily meets with her manager to review current project status. Prior 
to their meeting, Emily’s manager can gather revenue information from the 
Revenue screen. During the meeting, they can discuss any adjustments that need to 
be made. 
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Project Revenue Schedules 7

Each professional services organization requires various ways of looking at revenue. 
One level of management may be interested in the margins of their most important 
projects over time while another organization might focus more heavily on 
projections or bookings. Across these varied levels of management, organizations 
might choose to focus on monthly billing, one time revenues, or recurring revenue 
streams. Revenue schedules were designed with exactly these requirements in 
mind. 

Project managers can associate multiple types of revenue with a project with each 
revenue schedule item. For example, booked, forecasted, backlogged, and burned.

Just as important as tracking data for individual projects is the ability to analyze it 
in the aggregate. Revenue analysis allows you to instantly view a graphical 
representation of the health of a project. With the ad-hoc reporting of the various 
revenue streams and timing by account, location, or project type, you are better 
equipped to make more informed and more timely business decisions to help 
maximize resource utilization and profitability.

To add a new project revenue

1 Navigate to the Projects screen.

2 From the Show drop-down list, select My Projects.

3 In the Projects list, select the project with which the revenue will be added.

4 Click the Revenues view tab.

5 In the Revenues list, click the menu button and then click New Record.

6 In the new row, complete the necessary fields, click Save.
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Project Revenue Chart 7

The chart view provides a graphical representation which allows you to analyze 
revenue data.

To view revenue data using the Chart view

1 Navigate to the Projects screen.

2 From the Show drop-down list, select My Projects.

3 In the Projects list, select the project for which the information will be displayed.

4 Click the Revenues view tab.
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5 In the Revenues list, from the Show drop-down list, select Chart.

Your data will be displayed in graphical form. Summary values for each chart 
element will be displayed by the mouse-over feature.

NOTE: Use the By and Then drop-down lists on the Chart view to summarize your 
data by a variety of segments.

6 You can change the look and information displayed on the chart by clicking the 
Show, By, and Then drop-down arrows and selecting different values.
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